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Document Conventions

The following table lists the text conventions that are used throughout this guide.

TABLE 1 Text Conventions

Convention Description Example

monospace Identifies command syntax device (config) # interface ethernet 1/1/6
examples

bold User interface (Ul) components On the Start menu, click All Programs.

such as screen or page names,
keyboard keys, software buttons,
and field names

italics Publication titles Refer to the Ruckus Small Cell Release Notes for more information.

Notes, Cautions, and Warnings

Notes, cautions, and warning statements may be used in this document. They are listed in the order of increasing severity of
potential hazards.

NOTE
A NOTE provides a tip, guidance, or advice, emphasizes important information, or provides a reference to related
information.

ATTENTION
An ATTENTION statement indicates some information that you must read before continuing with the current action or
task.

CAUTION
A CAUTION statement alerts you to situations that can be potentially hazardous to you or cause damage to

hardware, firmware, software, or data.

DANGER
A DANGER statement indicates conditions or situations that can be potentially lethal or extremely hazardous to you.
Safety labels are also attached directly to products to warn of these conditions or situations.
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Command Syntax Conventions

Bold and italic text identify command syntax components. Delimiters and operators define groupings of parameters and their
logical relationships.

Convention Description

bold text Identifies command names, keywords, and command options.
italic text Identifies a variable.

[1 Syntax components displayed within square brackets are optional.

Default responses to system prompts are enclosed in square brackets.

{x|y|z} A choice of required parameters is enclosed in curly brackets separated by vertical bars. You must select one of the
options.

x|y A vertical bar separates mutually exclusive elements.

<> Nonprinting characters, for example, passwords, are enclosed in angle brackets.

Repeat the previous element, for example, member[member...].

\ Indicates a “soft” line break in command examples. If a backslash separates two lines of a command input, enter the
entire command at the prompt without the backslash.

Document Feedback

Ruckus is interested in improving its documentation and welcomes your comments and suggestions.
You can email your comments to Ruckus at ruckus-docs@arris.com.
When contacting us, include the following information:
*  Document title and release number
*  Document part number (on the cover page)
*  Page number (if appropriate)
For example:
*  Ruckus SmartZone Upgrade Guide, Release 5.0
*  Part number: 800-71850-001 Rev A
* Page7?

Ruckus Product Documentation Resources

Visit the Ruckus website to locate related documentation for your product and additional Ruckus resources.

Release Notes and other user documentation are available at https://support.ruckuswireless.com/documents. You can locate the
documentation by product or perform a text search. Access to Release Notes requires an active support contract and a Ruckus
Support Portal user account. Other technical documentation content is available without logging in to the Ruckus Support Portal.

White papers, data sheets, and other product documentation are available at https://www.ruckuswireless.com.

Ruckus loT Controller Software Installation Guide , 1.2
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Online Training Resources

To access a variety of online Ruckus training modules, including free introductory courses to wireless networking essentials, site
surveys, and Ruckus products, visit the Ruckus Training Portal at https://training.ruckuswireless.com.

Contacting Ruckus Customer Services and
Support

The Customer Services and Support (CSS) organization is available to provide assistance to customers with active warranties on
their Ruckus products, and customers and partners with active support contracts.

For product support information and details on contacting the Support Team, go directly to the Ruckus Support Portal using
https://support.ruckuswireless.com, or go to https://www.ruckuswireless.com and select Support.

What Support Do | Need?

Technical issues are usually described in terms of priority (or severity). To determine if you need to call and open a case or access
the self-service resources, use the following criteria:
e Priority 1 (P1)—Critical. Network or service is down and business is impacted. No known workaround. Go to the Open a
Case section.
*  Priority 2 (P2)—High. Network or service is impacted, but not down. Business impact may be high. Workaround may be
available. Go to the Open a Case section.
*  Priority 3 (P3)—Medium. Network or service is moderately impacted, but most business remains functional. Go to the
Self-Service Resources section.

*  Priority 4 (P4)—Low. Requests for information, product documentation, or product enhancements. Go to the Self-
Service Resources section.

Open a Case
When your entire network is down (P1), or severely impacted (P2), call the appropriate telephone number listed below to get
help:

* Continental United States: 1-855-782-5871

* Canada: 1-855-782-5871

* Europe, Middle East, Africa, Central and South America, and Asia Pacific, toll-free numbers are available at https://
support.ruckuswireless.com/contact-us and Live Chat is also available.

*  Worldwide toll number for our support organization. Phone charges will apply: +1-650-265-0903

We suggest that you keep a physical note of the appropriate support number in case you have an entire network outage.

Self-Service Resources

The Ruckus Support Portal at https://support.ruckuswireless.com offers a number of tools to help you to research and resolve
problems with your Ruckus products, including:

*  Technical Documentation—https://support.ruckuswireless.com/documents

Ruckus loT Controller Software Installation Guide , 1.2
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*  Community Forums—https://forums.ruckuswireless.com/ruckuswireless/categories
* Knowledge Base Articles—https://support.ruckuswireless.com/answers
*  Software Downloads and Release Notes—https://support.ruckuswireless.com/#products_grid
*  Security Bulletins—https://support.ruckuswireless.com/security
Using these resources will help you to resolve some issues, and will provide TAC with additional data from your troubleshooting

analysis if you still require assistance through a support case or RMA. If you still require help, open and manage your case at
https://support.ruckuswireless.com/case_management.
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Introduction to Ruckus loT Controller

The Ruckus loT Controller is a versatile easy-to-deploy service and management component that allows for integration of
Internet of Things (IoT) devices and loT services for a wide range of use cases. It provides a robust, secure, scalable,
interoperable, and well-managed general transport between loT devices and cloud services.

The Ruckus loT Controller is an open-programmable framework that exposes north-bound APIs and is thereby a highly flexible
loT transport for Ruckus partners to integrate a wide range of 10T services and solutions for the enterprise and beyond.

This guide provides information about how to install the Ruckus loT Controller on a supported hypervisor. Topics include the list
of supported hypervisors and Ruckus loT Controller installation instructions using the .OVA file.

NOTE
If release notes are shipped with your product and the information there differs from the information in this guide,
follow the instructions in the release notes.

This guide is intended for use by those responsible for installing and setting up network equipment. It assumes a basic working
knowledge of local area networking, wireless networking, and wireless devices.
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System Requirements for Installing Ruckus loT
Controller on a Hypervisor

Ruckus 10T Controller supports a number of hypervisors and requires a virtual machine (VM).

The following table lists the hypervisors (and their release versions) on which you can install the Ruckus loT Controller.

TABLE 2 Supported Hypervisors

Hypervisor Vendor Version

ESXi VMware 5.5 and later
VM VirtualBox Oracle 5.1.20 and later
VM Player VMware 12 or later

The virtual machine (VM) on which the Ruckus loT Controller is installed must meet the following requirements:
*  The VM for the Oracle VM VirtualBox hypervisor must have a minimum of 2 vCPUs, 2 GB RAM, and 8 GB HDD.
* The VM for the VMware ESXi hypervisor must have a minimum of 2 vCPUs, 2 GB RAM, and 8 GB HDD.
* The VM for the VM Player hypervisor must have a minimum of 2 vCPUs, 2 GB RAM, and 8 GB HDD.
*  Ports 80, 443, 1883, and 8883 must be open.

NOTE
For a high-scale deployment, Ruckus recommends a minimum of 4 vCPUs and 4 GB RAM.

Installing Ruckus lIoT Controller on Oracle VM
VirtualBox

The Ruckus loT Controller can be installed on an Oracle VM VirtualBox using an .OVA file.

NOTE
Ruckus loT Controller can be installed on a Mac or a Windows 64-bit machine.
Complete the following steps to install Ruckus loT Controller on a Mac.

1. Download the Ruckus loT Controller distribution package in the .OVA file format from the Ruckus Support website at
https://support.ruckuswireless.com.

Ruckus loT Controller Software Installation Guide , 1.2
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2. Open the Oracle VM VirtualBox Manager and select File > Import Appliance.
FIGURE 1 Oracle VM VirtualBox Manager

@& VirtualBox Iau Machine Window Help © Q = 75% @ Thu3:45PM Shriram Q

o o Import Appliance... 8l Oracle VM VirtualBox Manager

f! Export Appliance... $BE 9 B%
ZLN“( | Virtual Media Manager... ¥®D =] Details v o
New sc  Host Network Manager... $#W

Machine Tools Global Tools

Welcome to VirtualBox!

The left part of this window lists all virtual machines and virtual machine groups on your computer. The list is empty
now because you haven't created any virtual machines yet.

In order to create a new virtual machine, press the New button in the main tool bar located at the top of the window.

You can press the 887? key to get instant help, or visit www.virtualbox.org for more information and latest news.

The installation begins.

Ruckus loT Controller Software Installation Guide , 1.2
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Installing Ruckus loT Controller on Oracle VM VirtualBox

3. Import the .OVA file of the virtual appliance and click Continue.

FIGURE 2 Importing the Virtual Appliance
Appliance to import

VirtualBox currently supports importing appliances saved in the Open
Virtualization Format (OVF). To continue, select the file to import
below.

/Users/shriram/Downloads/vriot-1.2.0.0.x.0va| LA

1 Expert Mode 0 ue Cancel

Ruckus loT Controller Software Installation Guide , 1.2
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4. Confirm the appliance settings and click Import.

FIGURE 3 Importing the Appliance Settings

o Oracle VM VirtualBox Manager
Lt
: 2o
- . '|
New Machine Tools Global Tools

Appliance settings

These are the virtual machines contained in the appliance and the
suggested settings of the imported VirtualBox machines. You can
change many of the properties shown by double-clicking on the items

and disable others using the check boxes below. 5
Virtual System 1 r
%2 Name Ruckus loT Controller
E Guest OS Type Ubuntu (84-bit)
{4 CPU 2
# RAM 2048 MB
i’ Network Adapter v| Intel PRO/1000 MT Serv...

<> Storage Controller (IDE) PlIX4

Reinitialize the MAC address of all network cards

Appliance is not signed

j Restore Defaults Go Back Import Cancel [
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Installing Ruckus loT Controller on Oracle VM VirtualBox

5. Accept the terms of the license agreement and click Agree.

FIGURE 4 License Agreement

The virtual system "Ruckus loT Controller"
requires that you agree to the terms and conditions
of the software license agreement shown below.

Click Agree to continue or click Disagree to cancel
the import. i

i |

RUCKUS WIRELESS, INC.

Ruckus loT Controller (RloT Controller) Software i
License

PLEASE READ THIS SOFTWARE LICENSE
CAREFULLY. RUCKUS WIRELESS, INC.
("RUCKUS") IS WILLING TO LICENSE THE
SOFTWARE

TO YOU ("LICENSEE") ONLY ON THE /
CONNITION THAT THF | ICFNSFF ACCEPRTS Al |

Print... Save... Disagree Agree

When the import has completed, the Ruckus loT Controller .OVA file runs in VirtualBox.

Ruckus loT Controller Software Installation Guide , 1.2
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FIGURE 5 Ruckus 10T Controller .OVA File Running in VirtualBox

| NON Oracle VM VirtualBox Manager
L 2
* = eem o . U
wé W v ‘| v v
New Settings Start Machine Tools Global Tools
Ruckus loT Contr... E General = Ppreview
O Powered Off Name: Ruckus loT Controller
Operating System: Ubuntu (64-bit)
4] system
Base Memory: 2048 MB Ruckus loT Controller
Processors: 2

Boot Order: Floppy, Optical, Hard Disk
Acceleration:  VT-x/AMD-V, Nested Paging,
PAE/NX, KVM

Paravirtualization

= Display

Video Memory: 16 MB
Remote Desktop Server: Disabled
Video Capture: Disabled
Storage

Controller: IDE
Controller: SCSI
SCSI Port 0: vriot-1.0.0.0.21.vmdk (Normal, 8.00 GB)

= Audio

L PR . YO ~ Al

6. Select Bridged Adapter to configure the VirtualBox interfaces.

FIGURE 6 VM Interface Configuration

vriot - Network

EEE @ & O

General System Display Storage Audio Network Ports Shared Folders User Interface

- Adapte '.i Adapter 2  Adapter 3  Adapter 4

Enable Network Adapter

System

Attached to: = Bridged Adapter u

Name: en7: Apple USB Ethernet Adapter 2]
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7. Power on the virtual machine and wait for the login prompt.
FIGURE 7 Ruckus loT Controller Login Prompt

Ruckus loT Controller [Running]

[Ruckus IoT Controller

8. Login to the virtual machine using the username "admin" and password "admin".

Ruckus loT Controller Software Installation Guide , 1.2
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9. Enter 1inthe Enter Choice field to get the IP address of the virtual machine.

This information is needed to access the Ruckus IoT Controller Initialization page.

FIGURE 8 Displaying the IP Address

uRIoT Controller
Main Menu

Get Network Info

Get Application Info
NTP Setting

Restart Application
Reboot System

Reset Systenm

Command Prompt

Comm Debugger

Log Off

Enter Choice: 1

IP (lo): 127.0.0.1/8

IP (ethO): 192.168.100.151/24
Hostname : uriot

DNS domain:

FODN: uriot

DNS: 172.19.0.5 172.17.17.16

Ruckus loT Controller Software Installation Guide , 1.2
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Installing Ruckus loT Controller on Oracle VM VirtualBox

10. Open a web browser on your host machine and enter the IP address of the VM in the address bar.
HTTP and HTTPS on ports 80 and 443 are supported.

The Initialization page is displayed.

FIGURE 9 Intialization Page

Initialization

Select the services you need and click on next button

Required Services Optional Services

¥ Pubsub Server EM Bluemix Integration

#| Enable SSL

< Pubsub Client

</ Queue
</ Database Initiallize

# loT Device Manager AP

11. Select the required services and click Next.
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12. Confirm the configuration information and click Start.

FIGURE 10 Initial VM and IP Configurations

T RuUCKUS koT APl

Initialization

Select the services you need and click on start button

WM Configurations
Hostname

wriat

Time Zone

AmericalLos_Angeles -

Set Time Automatically using NTP @ Set Time Manually i

The Ruckus loT Controller Login page is displayed.

FIGURE 11 Ruckus loT Controller Login Page

IP Configurations
DHCP

IP Address:

Netmask:

Gateway:

DHS Server 1:

DNS Server 2:

n%:

RuckusloT Controller

Static @
172.16.113.29
155.155.154.0
172.16.113.255

172.16.200.3

1.0.0.0.16 Version
Ths Jul 05 2018 09:4%:40

(\ 172,16.200.5

Username:

Passward;

13. Enter the username "admin" and password "admin".

20

Login
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Installing Ruckus loT Controller on a VMware ESXi

You are ready to configure and start the Ruckus loT Controller services. Refer to the Ruckus loT Controller Configuration Guide for
more information.

Installing Ruckus loT Controller on a VMware
ESXi

The Ruckus loT Controller can be installed on a VMware ESXi hypervisor using an .OVA file.

1. Download the Ruckus IoT Controller distribution package in the .OVA file format from the Ruckus Support website at
https://support.ruckuswireless.com.

2. Open VMware ESXi and select Virtual Machines from the Navigator pane.

FIGURE 12 Creating or Registering Virtual Machines

vmware ESXi” r00t@10.137.36.15 v | Help v | (Cley -
“I% Navigator (%1 localhost.video54.local - Virtual Machines
v E] Host
Manage ﬁ] Create / Register VM Console ower 0 ower off Suspen ‘ c‘ Refresh ‘ ctions /0, Search
Monitor ~ Virtual macl Create or register a virtual machine ~ Status ~ Used space ~  Guest 0S ~  Host name ~ HostCPU ~ Host memoryv
& Virtual Machines - ") ) Automation-ubuntu-16.04-installer @ Nor... 1418GB Ubuntu Linux (64-bit) Unknown 0MHz omB
E3 storage (51 Automation-Stage-Server @ Nor... 11.55GB Ubuntu Linux (64-bit) Unknown 0 MHz 0MB
Q Networking ~| {51 Automation-Production-Server @ Nor... 15.48GB Ubuntu Linux (64-bit) Unknown 0 MHz 0MB
51 Gateway-Vriot @ Nor... 7.72GB Ubuntu Linux (64-bit) Unknown 0 MHz 0MB
~ {51 IBM-Vriot-1.3.0.0.1 @ Nor... 561GB Ubuntu Linux (64-bit) Unknown 0 MHz 0MB
B QA-visionline @ Nor... 17.27GB Microsoft Windows Se...  Unknown 18 MHz 6.02 GB
5 ga-win-dns-200 @ Nor... 11.52GB Microsoft Windows Se... Unknown 25 MHz 3.93GB
" {51 Gateway-vsz-10019 @ Nor... 29.85GB Other (32-bit) Unknown 0 MHz 0MB
17 items 4

Recent tasks

Task ~  Target ~ | Initiator ~ | Queued v  Started v Result ~  Completed v v

3. Click Create/Register VM.

Ruckus loT Controller Software Installation Guide , 1.2
Part Number: 800-72091-001 Rev A 21


https://support.ruckuswireless.com

Installing Ruckus IoT Controller on a Hypervisor
Installing Ruckus loT Controller on a VMware ESXi

22

4. On the New virtual machine page, click Select creation type, and select Deploy a virtual machine from an OVF or

OVA file. Click Next.

FIGURE 13 Select Creation Type Page

ﬁ New virtual machine

b4 1 Select creation type

2 Select OVF and VMDK files
3 Select storage

4 License agreements
5 Deployment options
6 Additional settin:

Select creation type

How would you like to create a Virtual Machine?

Create a new virtual machine

Deploy a virtual machine from an OVF or OVA file

Register an existing virtual machine

This option guides you through the process of creating a
virtual machine from an OVF and VMDK files.

Back Next Finish

4
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5. Click Select OVF and VMDK files, enter a name for the virtual machine, and select the OVF file. Click Next.

FIGURE 14 Select OVF and VMDK Files Page

ﬁ New virtual machine - VRIOT-CONTROLLER

v 1 Select creation type Select OVF and VMDK files

2 Select OVF and VMDK files Select the QVF and VMDK files or OVA for the VM you would like to deploy

3 Select storage
4 License agreements

Enter a name for the virtual machine.

| VRIOT-CONTROLLER

5 Deployment options
6 Additional settin

Virtual machine names can contain up to 80 characters and they must be unique within each ESXi instance.

x @ vriot-1.2.0.0.x.ova

| Back || Next | Finish

4
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6. Click Select storage, and select the datastore in which you want to save the configuration and disk files. Click Next.

FIGURE 15 Select Storage Page

24

ﬁ New virtual machine - VRIOT-SAMPLE
v 1 Select creation type Select storage
¥ 2 Select OVF and VMDK files Select the datastore in which to store the configuration and disk files.
24 3 Select storage
Silicensstagieements The following datastores are accessible from the destination resource that you selected. Select the destination datastore for
5 Deployment options the virtual machine configuration files and all of the virtual disks.
6 Additional settin:
Name ~ Capacity ~ Free ~  Type ~ Thinpro... v Access
datastorel 3.63TB 3.34 TB VMFS5 Supported Single
1 items
| Back || Next || Finish
&
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7. Click License agreements to accept the terms and conditions of software license and click Agree.

FIGURE 16 License Agreement

The virtual system "Ruckus loT Controller"
requires that you agree to the terms and conditions
of the software license agreement shown below.

Click Agree to continue or click Disagree to cancel
the import. i

i |

RUCKUS WIRELESS, INC.

Ruckus loT Controller (RloT Controller) Software i
License

PLEASE READ THIS SOFTWARE LICENSE
CAREFULLY. RUCKUS WIRELESS, INC.
("RUCKUS") IS WILLING TO LICENSE THE
SOFTWARE

TO YOU ("LICENSEE") ONLY ON THE /
CONNITION THAT THF | ICFNSFF ACCEPRTS Al |

Print... Save... Disagree Agree
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8. Click Deployment options, and select the Network mappings and Disk provisioning. Click Next.

FIGURE 17 Deployment Options Page

ﬁ New virtual machine - VRIOT-SAMPLE

Deployment options

Select deployment options

v 1 Select creation type
v 2 Select OVF and VMDK files

v 3 Select storage

84 4 Deployment options
5 Ready to complete

Network mappings VM Network | VM Network

Disk provisioning © Thin ) Thick

[ Back ][ Next ] Es

4
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9. Click Ready to complete and review the settings. Click Finish.

FIGURE 18 Ready to Complete Page

ﬁ New virtual machine - VRIOT-SAMPLE

¥ 1 Select creation type Ready to complete
v’ 2 Select OVF and VMDK files

Review your settings selection before finishing the wizard

v’ 3 Select storage
v 4 Deployment options
hd 5 Ready to complete

Product
VM Name
Disks
Datastore

Provisioning type

Network mappings

Guest OS Name

vriot

VRIOT-SAMPLE
vriot-1.0.0.0.21.vmdk
datastore1

Thin

VM Network: VM Network

Unknown

i ‘ ' 2 Do not refresh your browser while this VM is being deployed.
.

Next [ Eibieh

|| cancel | )
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10. Log in to the virtual machine using the username "admin" and password "admin".
FIGURE 19 Ruckus loT Controller Login Prompt

Ruckus loT Controller [Running]

[Ruckus IoT Controller

Ruckus loT Controller Software Installation Guide , 1.2
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11. Enter 1 in the Enter Choice field to get the IP address of the virtual machine.

This information is needed to access the Ruckus IoT Controller Initialization page.

FIGURE 20 Displaying the IP Address

uRIoT Controller
Main Menu

Get Network Info

Get Application Info
NTP Setting

Restart Application
Reboot System

Reset Systenm

Command Prompt

Comm Debugger

Log Off

Enter Choice: 1

IP (lo): 127.0.0.1/8

IP (ethO): 192.168.100.151/24
Hostname : uriot

DNS domain:

FODN: uriot

DNS: 172.19.0.5 172.17.17.16
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12. Open a web browser on your host machine and enter the IP address of the VM in the address bar.

HTTP and HTTPS on ports 80 and 443 are supported.

The Initialization page is displayed.

FIGURE 21 Intialization Page

Initialization
Select the services you need and click on next button
Required Services

Pubsub Server

Enable SSL

Pubsub Client

nd Access Manager

Queue Service

Database Initiallize!

oT Device Manager AP

13. Select the required services and click Next.

Optional Services

EM Bluemix Integration
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14. Confirm the configuration information and click Start.

FIGURE 22 Initial VM and IP Configurations

rf 1 loT API 1.0.0.0.16 Version
_ SUCHES i Thu Jul 05 2018 09:4%9;40

Initialization
Select the services you need and click on start butten
WM Configurations IP Configurations
Hostname
DHCP Static @
Wit
IP Address: 172.16.113.29
Time Zone
Netmask:
AmericalLos_Angeles - 255.235.254.0
Gateway: q
Set Time Automatically using NTP @ Set Time Manually i 172.16.113.253
DHS Server 1: 172, 16.200.3
DNS Server 2: (\ 172,16.200.5 3

The Ruckus loT Controller Login page is displayed.

FIGURE 23 Ruckus IoT Controller Login Page

n%:

RuckusloT Controller

Username:

Passward:

Login

15. Enter the username "admin" and password "admin".
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You are ready to configure and start the Ruckus loT Controller services. Refer to the Ruckus loT Controller Configuration Guide for

more information.

Installing Ruckus loT Controller Using VMware

Player

The Ruckus loT Controller can be installed on a virtual machine using VMware Player.

1. Download the Ruckus IoT Controller distribution package in the .OVA file format from the Ruckus Support website at
https://support.ruckuswireless.com.

2. OpenVMware Player.

From the Player menu, select File > Open, and select the .OVA file for the Ruckus IoT Controller.

FIGURE 24 Selecting the .OVA File

Player ™ | x
File
Power
Removable Devices
Send Ctrl+alt+Dal
Manage
1 Full Screen
Unity
Help

Exit

B i

Chrl+ Alt+Enter

» (2] New Virtual Machire... Ctrl+N
Open... cwrl+0  Jare
Download Virtual Appliance Iaver

Preferences...

The installation begins.

32

Create a New Virtual Machine

Create a new virtual machine, which will then be added to
the top of your lIbrany.

Open a Virtual Machine

Cpen an existing virtual machine, which will then be added
to the top of your library.

Upgrade to VMware Workstation Pro

Get advanced features such as snapshots, virtual network
management, and mare,

Help

View online help.

Ruckus loT Controller Software Installation Guide , 1.2
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4. Accept the terms of the end user license agreement and click Next.

FIGURE 25 End User License Agreement

_
I

Player ¥ .

Import Virtual Machine

End User License Agreement
Accept the end user license agreements.

Installing Ruckus IoT Controller on a Hypervisor
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RUCKUS WIRELESS, INC.

1) Definitions

available by Ruckus.

Ruckus IoT Controller (RIoT Controller) Software License

PLEASE READ THIS SOFTWARE LICENSE CAREFULLY. RUCKUS WIRE
TO YOU ("LICENSEE") ONLY ON THE CONDITION THAT THE LICENS
IF A USER ACCEPTS THIS LICENSE, OR DOWNLOADS, USES OR INS™
OR CONTRACTOR FOR THE BENEFIT OF, A COMPANY, THAT COMP/
THAT IT HAS THE POWER AND AUTHORITY TO ACCEPT THIS AGRE
BY DOWNLOADING, INSTALLING AND/OR USING THE SOFTWARE, L
AGREES TO BE BOUND BY ITS TERMS AND COMDITIONS. IF LICENS
LICENSE, RUCKUS IS UNWILLING TO LICENSE THE SOFTWARE. IN ™
THE SOFTWARE AND SHALL BE GIVEN A FULL REFUND OF ANY LICE

"Device" means a single Ruckus access point on Licensee's network.
"Documentation” means the published technical manuals, including any

EI accept the terms of the license agreement.

Help

Ruckus loT Controller Software Installation Guide , 1.2
Part Number: 800-72091-001 Rev A
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5. Enter a name and storage path for the virtual machine and click Import.

FIGURE 26 Naming the Virtual Machine

| .
| Player ~ B 1
i

Import Virtual Machine

Store the new Virtual Machine
Provide a name and local storage path for the new virtual machine.

Name for the new virtual machine:

| RIoT Controller

Storage path for the new virtual machine:

| C:\Users\test\Documents\Virtual Machines\RIoT Controller Browse. ..

< Back Cancel

VMware Player begins importing the Ruckus loT Controller.

Ruckus loT Controller Software Installation Guide , 1.2

34

Part Number: 800-72091-001 Rev A



Installing Ruckus IoT Controller on a Hypervisor
Installing Ruckus loT Controller Using VMware Player

FIGURE 27 Importing the Ruckus loT Controller

Player ~ B I

Importing RloT Controller

Importing RIoT Controller
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6. Login to the Ruckus loT Controller using the username "admin" and password "admin".

FIGURE 28 Ruckus loT Controller Login Prompt

Ruckus IoT Controller

uriot login: _
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7. From the Player menu, select Manage > Virtual Machine Settings to open the settings for the virtual machine.

FIGURE 29 Opening the Virtual Machine Settings

Player ¥ = 'ﬁjr‘ B T h
File >

Q) Power >

( | Removable Devices >

£TL' Send Ctrl+Alt+Del

X\ Manage ? Reinstall VMware Tools

TT Full Screen Ctrl+Alt+Enter |7 Message Log

D._] Unity 'JJ::—'_LI Virtual Machine Settings... Ctrl+D
Help >
Exit
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8. Click the Bridged network connection and select the appropriate host network adapter for automatic bridging. Click OK.

FIGURE 30 Virtual Machine Settings Page

Hardware Options

Device Summary
B8 Memory 2 GB
[ Processors 2
et Hard Disk (SCSI) 8 GB
@Netwurk Adapter Bridged (Automatic)
EDisplayr 1 monitor
Automatic Bridging Settings X

Select the host network adapter(s) you want to automatically
bridge:

D ASIX AX88179 USB 3.0 to Gigabit Ethernet Adapter #2
[ ]PANGP Virtual Ethernet Adapter

[ |Microsoft Wi-Fi Direct Virtual Adapter

[ |Bluetooth Device (Personal Area Network)

[ intel(R) Dual Band Wireless-AC 8260

Intel(R) Ethernet Connection 1219-LM

DJuniper Network Connect Virtual Adapter

[ virtualBox Host-Only Ethernet Adapter

Cancel

Help

Add... Remove

38

Device status

Connected
Connect at power on ,

Network connection

@ Bridged: Connected directly to the physical network
D Replicate physical network connection state
. Configure Adapters

(C)NAT: Used to share the host's IP address
(_)Host-only: A private network shared with the host
() Custom: Spedific virtual network

VMnet0 (Auto-bridging)
() LAN segment:

LAN Segments.... Advanced... .

OK Cancel Help
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9. Inthe Ruckus loT Controller Main Menu, enter 5 in the Enter Choice field to reboot the Ruckus loT Controller.

FIGURE 31 Rebooting Ruckus lIoT Controller

Player ¥ ~ 'ﬁjr‘ B I h « =

uRIoT Controller
Main Menu

Get Network Info

Get Application Info
NTP Setting

Restart Application
Reboot System

Reset System

Command Prompt

Conm Debugger

Log Off

o= I = ) L

Enter Choice: 5
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10. Enter 1in the Enter Choice field to get the IP address of the virtual machine.

This information is needed to access the Ruckus IoT Controller Initialization page.

FIGURE 32 Displaying the IP Address

uRIoT Controller
Main Menu

Get Network Info

Get Application Info
NTP Setting

Restart Application
Reboot System

Reset Systenm

Command Prompt

Comm Debugger

Log Off

Enter Choice: 1

IP (lo): 127.0.0.1/8

IP (ethO): 192.168.100.151/24
Hostname : uriot

DNS domain:

FODN: uriot

DNS: 172.19.0.5 172.17.17.16
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11. Open a web browser on your host machine and enter the IP address of the VM in the address bar.
HTTP and HTTPS on ports 80 and 443 are supported.

The Initialization page is displayed.

FIGURE 33 Intialization Page

Initialization

Select the services you need and click on next button
Required Services Optional Services

Pubsub Server EM Bluemix Integration

Enable SSL

Pubsub Client

nd Access Manager

Queue Service

Database Initiallize!

oT Device Manager AP

12. Select the required services and click Next.
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13. Confirm the configuration information and click Start.

FIGURE 34 Initial VM and IP Configurations

T RuUCKUS koT APl

Initialization

Select the services you need and click on start button

WM Configurations
Hostname

wriat

Time Zone

AmericalLos_Angeles -

Set Time Automatically using NTP @ Set Time Manually i

The Ruckus loT Controller Login page is displayed.

FIGURE 35 Ruckus IoT Controller Login Page

IP Configurations
DHCP

IP Address:

Netmask:

Gateway:

DHS Server 1:

DNS Server 2:

n%:

RuckusloT Controller

Static @
172.16.113.29
155.155.154.0
172.16.113.255

172.16.200.3

1.0.0.0.16 Version
Ths Jul 05 2018 09:4%:40

(\ 172,16.200.5

Username:

Passward;

14. Enter the username "admin" and password "admin".

a2

Login
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You are ready to configure and start the Ruckus loT Controller services. Refer to the Ruckus loT Controller Configuration Guide for
more information.
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